Copyright

This manual, Copyright © 2019 Unigraf Oy. All rights reserved
Reproduction of this manual in whole or in part without a written permission of
Unigraf Oy is prohibited.

Notice

The information given in this manual is verified in the correctness on the date of issue. The
authors reserve the rights to make any changes to this product and to revise the information
about the products contained in this manual without an obligation to notify any persons about
such revisions or changes.

Edition

Date: 11 November 2019

Company Information

Unigraf Oy
Piispantilankuja 4
FI-02240 ESPOO
Finland
Tel. +358 9 859 550
mailto:info@unigraf.fi
https://www.unigraf.fi
http://www.unigraf-china.cn
Trademarks

Unigraf, UCD and TSI are trademarks of Unigraf Oy.
DisplayPort™ and the DisplayPort™ logo are trademarks owned by the
Video Electronics Standards Association (VESA®) in the United States and other countries.
USB™, USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum Inc.
HDCP is a trademark of Digital Content Protection LLC.
Windows® 10, Windows® 8, Windows® 7 and Windows® XP are trademarks of
Microsoft Corporation.
All other trademarks are properties of their respective owners.

Limited Warranty

Unigraf warrants its hardware products to be free from defects in workmanship and materials,
under normal use and service, for twelve (12) months from the date of purchase from Unigraf
or its authorized dealer.

If the product proves defective within the warranty period, Unigraf will provide repair or
replacement of the product. Unigraf shall have the whole discretion whether to repair or
replace, and replacement product may be new or reconditioned. Replacement product shall be
of equivalent or better specifications, relative to the defective product, but need not be
identical. Any product or part repaired by Unigraf pursuant to this warranty shall have a
warranty period of not less than 90 days, from the date of such repair, irrespective of any
earlier expiration of original warranty period. When Unigraf provides replacement, then the
defective product becomes the property of Unigraf.

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf
will provide instructions for returning the defective product.

CE Mark

UCD-300 products meet the essential health and safety requirements, is in conformity with and
the CE marking has been applied according to the relevant EU Directives using the relevant
section of the corresponding standards and other normative documents.
Table of Contents

1. About This Manual .................................................................................................................. 5
   Purpose ................................................................................................................................. 5
   Product and Driver Version ................................................................................................. 5
   Notes .............................................................................................................................. 5

2. Introduction ............................................................................................................................ 6
   Product Description ............................................................................................................ 6
   Functional Description ...................................................................................................... 6

3. Installation ............................................................................................................................. 9
   Unpacking ........................................................................................................................ 9
   Installation Package .......................................................................................................... 9
   Software Installation ......................................................................................................... 9
   Unigraf Electrical Test Cable ............................................................................................ 10

4. Firmware Update .................................................................................................................. 11
   Updated Modules ............................................................................................................. 12

5. License Manager ................................................................................................................... 13

6. UCD Console ........................................................................................................................ 15
   Device Selection ............................................................................................................. 15

7. USB-C Monitoring ................................................................................................................ 17
   Edit PDO Information Tab ................................................................................................. 19
   Power Load ....................................................................................................................... 20
   Cable Info Tab .................................................................................................................. 21

8. DP Alt Mode Reference Sink ................................................................................................ 22
   Video Tab ......................................................................................................................... 22
   Audio Tab ......................................................................................................................... 25
   Link Tab ........................................................................................................................... 27
   EDID Tab .......................................................................................................................... 29
   DPCD Tab ........................................................................................................................ 31
   HDCP Tab ........................................................................................................................ 33
   SDP Tab ............................................................................................................................ 35
   Source DUT Testing Tab ................................................................................................. 36

9. DP Alt Mode Reference Source ............................................................................................ 39
   Pattern Generator Tab ...................................................................................................... 39
   Audio Generator Tab ....................................................................................................... 42
   Link Tab ........................................................................................................................... 43
   EDID Tab .......................................................................................................................... 44
   DPCD Tab ........................................................................................................................ 46
   HDCP Tab ........................................................................................................................ 48
   Sink DUT Testing Tab ....................................................................................................... 50

10. Event Log ............................................................................................................................... 52
    DP AUX Analyzer ........................................................................................................... 54

11. EDID Editor .......................................................................................................................... 60
    Appendix A. Product Specification .................................................................................. 62
        UCD-340 ....................................................................................................................... 62
    Appendix B. Licensing ........................................................................................................ 63
    Appendix C: Predefined Timings ...................................................................................... 68
    Appendix D: Predefined Patterns .................................................................................... 69
    Appendix E: Sink and Source DUT Tests ......................................................................... 70
        CRC Based Video Test Set – DP Rx ........................................................................... 71
        Link Test Set – DP Rx ................................................................................................. 74
        USB-C Electrical Test Set – DP Rx and DP Tx ......................................................... 75
    Appendix F: Advanced Filters ......................................................................................... 79
1. ABOUT THIS MANUAL

Purpose

This guide is the User Manual of UCD Console user interface software for UCD-340, USB-connected interface test units for testing the features of USB Type-C interface. UCD Console can be used in a PC with Windows® 10 Windows® 8 or Windows® 7 operating system.

The purpose of this guide is to

- Provide an overview of the product and its features.
- Provide instruction for the user on how to install the software and the drivers.
- Introduce the HW features of the UCD-340 units.
- Provide instructions for the user how to use UCD Console software.

Product and Driver Version

This manual explains features found in UCD Console Software Package 1.8. Please consult Unigraf for differences or upgrades of previous versions.

Please consult the Release Notes document in the installation package for details of the SW and FW versions and changes to previous releases.

Notes

On certain sections of the manual, when important information or notification is given, text is formatted as follows. Please read these notes carefully.

<table>
<thead>
<tr>
<th>Note</th>
<th>This text is an important note</th>
</tr>
</thead>
</table>

5.
2. INTRODUCTION

Product Description

UCD display interface tester family consists of four USB 3.0 connected video interface test units UCD-400, UCD-323 HDDP Dual, UCD-301 Digital and UCD-340. The UCD Console is the common graphical user interface (GUI) for all UCD family units. UCD Console provides access to all functions of the unit.

UCD units feature a high-level Software Development Kit (SDK) for use in automated testing. It is called Test Software Interface (TSI). TSI allows for an easy integration of the Production and R&D testing routines into an automated test system environment. Please refer to TSI documentation for more details.

UCD-340 Product Features

- Test unit for testing power delivery and DP Alt Mode functions of USB-C interface
- Monitoring and control of data and power delivery roles of the USB-C interface
- High resolution DP alt mode video and audio capture up to 4K / UHD 60 Hz
- Compatible with HDCP versions 1.3 and 2.3
- Optional Power Test Unit for testing high voltage and power options
- High speed USB 3.0 host PC interface

Please refer to Product Specifications in the appendix of this document for details.

Functional Description

UCD-340 is an integrated test unit for verifying the performance of PD and DP Alt Mode functions in a USB Type-C device.

UCD-340 unit consist of a USB-C signal input stage with data multiplexer with either two directional data pass-through to USB2 or USB3 interfaces or connection to DP Alt Mode input / output block.

The USB-C input stage consists capability for electrically testing the continuity of input signals. An optional separate Power Test unit is sourcing or sinking the various voltages for testing USB-C power options.

The DP Alt Mode block includes frame grabber and pattern generator functions for emulating DP Alt Mode source and sink functions.


**UCD-340**

The image below describes the connections in **UCD-340** unit.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB-C</td>
<td>USB Type-C Connection to the evaluated device (DUT)</td>
</tr>
<tr>
<td>USB 3 Device</td>
<td>USB Type-A connector for an auxiliary USB 3.1 “Device” for data pass-through</td>
</tr>
<tr>
<td>USB 3 Host</td>
<td>USB Type-B connector for an auxiliary USB 3.1 “Host” for data pass-through</td>
</tr>
<tr>
<td>External Power Test Unit</td>
<td>Connector for Unigraf’s “USB-C External Power Test Unit”</td>
</tr>
<tr>
<td>Power in</td>
<td>+12 Vdc Power Supply Input</td>
</tr>
<tr>
<td>USB 3 to host PC</td>
<td>USB 3.0 connection to the controlling PC</td>
</tr>
</tbody>
</table>

**Note**
Capturing and sourcing high resolution video modes, especially 4K video modes set stringent requirements on the video cables and connectors. Please contact Unigraf for assistance and details about evaluated cables.

**Warning**
In order to avoid possible damage to UCD-340 unit and the PC, please **always attach the power cord (Power In) to UCD-340 unit first**, and after that connect the USB cable to your PC.
External USB-C Power Test Unit

Unigraf *External USB-C Power Test Unit* enables testing extended USB power options.

Please find below a matrix describing Power Source and Power Sink options of UCD-340 internally and with attached *Unigraf External Power Test Unit*. Please find description of controlling the power options with UCD Console later in this manual.

<table>
<thead>
<tr>
<th></th>
<th>5 V</th>
<th>9 V</th>
<th>12 V</th>
<th>15 V</th>
<th>20 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vbus Source capability</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UCD-340</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>UCD-340 with External USB-C Power Test Unit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>0.5 A</th>
<th>0.9 A</th>
<th>1.5 A</th>
<th>3 A</th>
<th>3 A</th>
<th>3 A</th>
<th>5 A</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vbus Sink capability</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UCD-340</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>UCD-340 with External USB-C Power Test Unit</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
3. INSTALLATION

Unpacking

The UCD-340 product shipment contains:

- The UCD-340 unit
- AC/DC Power supply (100 to 240 Vac 50/60 Hz input, +12 Vdc output)
- USB 3.0 compliant cable
- USB-C to USB-C test cable
- Unigraf Electrical test cable with units including Electrical Test

Installation Package

The UCD-300 software installation package can be obtained from Unigraf download page at [www.unigraf.fi/support/download-links](http://www.unigraf.fi/support/download-links). Please log in using the following credentials before an attempt to access download page:

Username: unigraf
Password: ruukintie

The installation package is a bundle between the components needed for UCD Console and for TSI SDK. The bundle contains the following items:

- Windows drivers (installed during set up)
- UCD Console software GUI (installed during set up)
- License Manager (installed during set up)
- UCD Configuration Utility (installed during set up)
- TSI SDK
- User Manuals including this document.

In some cases, you will need to update also the firmware of the unit. If in doubt, please contact Unigraf.

---

Note: The software should be installed before connecting the UCD-300 unit in your PC.

Note: System administrator's privileges are required for performing the installation.

Software Installation

- Start the installation by running **Unigraf Software Bundle Setup.exe**
  
  Once the installer has started, a welcome page is displayed. The welcome page shows the software package release version.

- Click **Next** to continue. In the next dialogs, you will be able to define the software components installed.

  The next two dialogs will allow you to define the installation folder in your PC and the Start Menu folder used.

- When you are ready with the selections, click **Install** to start the installation.

- Click **Finish** to exit the installation dialog.
Unigraf Electrical Test Cable

Some features of the Electrical Test function are available only when using the special Electrical Test Cable provided by Unigraf. Electrical Test Cable includes extra wires enabling UCD-340 to individually measure the electrical continuity of DUT’s four VBUS and four GND signals that are normally tied together at DUT’s end of the cable. Please refer to the image below for clarification.

Note

When attaching Unigraf Electric Test Cable, please make sure that the finger-screw is tightened all-the-way into its hole. When tightened, the finger-screw triggers a switch indicating the presence of Unigraf Electric Test Cable.

You can also verify that Unigraf Test Cable is plugged from UCD Console by selecting vertical Tab USB-C, horizontal tab Roles and Modes. The indicator text can be found in the bottom bar.

Two Electrical Test Cable Types

Please note that there are two versions for Unigraf Electrical Test Cable. The difference is the number of USB D+/− pairs included in the cable.

► If DUT has shorted USB2.0 pins A6 to B6 and A7 to B7 at the receptacle then choose cable One: In order to minimize in-cable signal coupling only one USB D+/− pair is included in the cable.

► If DUT has shorted USB2.0 pins routed to mux or similar, then choose cable Two: In order to enable electrical cable flip in cases where USB D+ lines and USB D− lines correspondingly have not been shorted together on Device side, both USB D+/− pairs are included in the cable. This cable marked with a label “2xUSB 2.0 PAIRS”.
4. FIRMWARE UPDATE

UCD Configuration Utility is used to load an updated firmware to the device. As an option, UCD Configuration Utility enables the user to select the operation roles present in the UCD-300 unit. The utility configures a firmware set for the selected operation roles and programs the firmware set to the device. Please contact Unigraf for details.

To update the firmware or create a new configuration on a UCD-300 device, please perform the following steps:

► Connect the UCD-300 unit to a power supply and connect the USB cable.

► Open UCD Console. Select Tools > Firmware update.

You can launch the utility alternatively by running the UCD Firmware Configuration in Start Menu > Unigraf / UCD-300 /

The first page of the utility indicates the firmware component versions present in the package. Please click Next.

► From the list of connected UCD-300 devices please select the one that you want to update. Click Next.
Updated Modules

The tool prompts you for selection of the firmware modules to be updated. It compares the modules in the selected device and omits the ones that are the same.

- When you are done, click **Next**.

  While the configuration is in progress you will be asked to power cycle the device between the parts.

Note: The procedure may take several minutes depending on the speed of the USB connection of the host PC.

- When completed, power cycle the device.

Note: The new firmware will be taken in use only when the device is powered up next time.
5. LICENSE MANAGER

Licensing

The features of UCD Console GUI are divided into groups based on the target use of the device. Some basic features can be used without licenses. Advanced feature groups have their dedicated licenses that open the related part of the GUI or enable the related control.

Unigraf licenses are provided as strings of characters, License Keys. Each License Key enables a dedicated function in one device. Each device has its dedicated Seed Number. Each License Key is tied to one Seed Number. License Keys can be freely used in any number of PCs.

License keys are managed with Unigraf License Manager. By default, shortcut to Unigraf License Manager can be found in Start Menu under: All programs/Unigraf/ TSI.

Please click Yes in the first dialog. License Manager can be run only with Administrator rights.

Note: System administrator's privileges are required for accessing the licenses.

License Manager GUI

Once the application starts up, it will look for any licensing enabled Unigraf device. If no suitable device families are detected, License Manager will exit. Please first select one of the available device families by clicking one of the device family selector buttons.

In the list of Attached Devices please select the device in question. You can find the serial number and the seed number of your device in a sticker attached to the bottom of your device.

The Back button will bring you back to the device family selection screen. The Refresh button will re-scan the system for installed hardware.
Managing Licenses

Seed Number
Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a unique Seed Number. You can find the Seed Number of the selected unit in the top of the dialog.

The Seed Number link in the dialog will allow you to copy & paste the Seed Number of the selected device for e.g. ordering Licenses.

Adding New License Keys
To add a new license key for a device, please enter the characters from the license sticker to the boxes provided. The License Manager will automatically move the caret across the edit boxes as you type. If you have the key in text format, copy it and paste to the leftmost box.

Once the license key is fully entered, click the Install. The license is authenticated and if it is valid, the license will appear in the list of installed licenses. If the key fails to authenticate, an error message is displayed. If this happens, please make sure that you have typed the key correctly and that the seed number on the license key sticker matches the seed number displayed seed number for the device.

Please note that to avoid confusion, some letters will never appear in a license key because they resemble numbers: For example, capital ‘G’ and number ‘6’ are very similar when printed with small font. When in doubt, use numbers.

Also, please notice, that characters that can’t be part of valid license key are not accepted as input. When appropriate an automatic conversion is applied while typing: For example, lower case letters are converted to upper case automatically.

Managing Installed Licenses
The Installed licenses list shows all currently installed licenses for the currently selected device. The list shows the actual license key, and what that key unlocks.

Remove Selected will uninstall selected licenses. To uninstall a license, click on the license and then click the Remove Selected button.

Export will allow you to save all installed licenses for the currently selected device into an INI file for backup and distribution to other PCs. Please notice that licenses from multiple devices can be exported into the same INI file.

Import will install licenses from an INI file for the currently selected device.
6. UCD CONSOLE

UCD Console is the graphical user interface (GUI) of UCD-300 family for desktop use. It provides the user access to all features of the unit. UCD Console also includes powerful debugging and analysis tools enabling the user to monitor the status of the interfaces and assist in the problem detection.

The various features of the UCD-300 are divided into interface specific screens and tabs. Each tab contains data and controls for a specific feature.

Device Selection

You can find the shortcut of UCD Console by default under Start Menu path: All programs/Unigraf/UCD-300. Once UCD Console GUI is launched the dialog provides a list of UCD-300 devices connected in the PC. Please select your target device by clicking on the appropriate button. If you cannot find your device in the list, please confirm the power and USB connection to the device and click the Rescan … button.

Select Role

The use of UCD-300 devices with UCD Console is divided in display interface specific roles. The structure of UCD Console varies between roles by having a varying set of tabs dedicated to functionalities available in the enabled role. Please find a detailed description of each role in the later chapters of this manual.

A full description of the functions and the licensing can be found in Appendix B. Licensing
Detaching Tabs

You can detach any of the UCD Console tabs into a separate window for being able to monitor and control separate features simultaneously. To detach a tab **Right-click** on a tab and select **Detach Page**. To glue the tab back to the main window, click on the red **Close button** in the top right-hand corner of the window or press `<Alt> + F4` on your keyboard.
In **USB-C Monitoring** dialog operator can evaluate the status of the USB-C connection, the various roles adopted, and the configuration of the DP Alternate Mode. The user can set the initial roles for the UCD-340 TE and the optional capabilities for UCD-340 in the PD Contract. Controls allow user also to swap roles and e.g. use the Cable Swap feature of Unigraf Electrical Test cable. USB-C related panel can be selected from the **USB-C** tab on the left edge of the GUI.

**USB-C Monitoring** dialog contains four horizontal tabs
- Roles and Modes
- Edit PDO Information
- External Power Load
- Cable Info

## Roles and Modes Tab

The **Roles and Modes** tab is divided into two parts: the left side is the **Status** panel while the right side provides the **Configuration** dialogs.

### Status

The status panel lists the various roles and statuses of UCD-340 after the connection negotiation with the USB-C DUT.

The uppermost group indicates the general statuses like **Power Role** and **Data Role**

**DP Alt Mode Configuration.**

**Fixed Supply PDO** (Power Data Objects) lists the PD status settings for the connection party acting as Source Port (in the shown case UCD-340).
**Contract RDO** (Request Data Objects) lists the PD status settings for the connection party acting as *Sink Port*.

The lowermost group lists the actual measured values of the Vbus, CC lines and Vconn.

**Configuration**

With UCD-340 user is able to electrically swap the roles of its CC lines to emulate flip of the connected cable. In this way the user can verify functionality of DUT CC block in both orientations.

In the Configuration dialog, the user can set the initial roles and configurations of UCD-340 USB-C interface for the connection. The Cable Orientation can be set only when Unigraf Electrical test cable is present.

The configuration for DP Alt Mode is divided into cases depending on UCD-340 USB-C interface role as Downwards Facing Port (DFP) or Upwards Facing Port (UFP).

**Swap**

The Swap buttons allows the user to request a swap of either Data role, Power role or the CC line where VCONN is applied.

**ET cable USB2.0 differential pairs**

There are two versions for Unigraf Electrical Test Cable. The difference is the number of USB D+/− pairs included in the cable. The reasoning is that if an unused pair is not terminated, it is a receiver of EMI and disturbs the electrical circuitry.

Cable with P/N 546117 has two USB2.0 pairs, while P/N 546114 has only one pair. Please update the control accordingly.

- If DUT has shorted USB2.0 pins A6 to B6 and A7 to B7 at the receptacle then choose cable One: In order to minimize in-cable signal coupling only one USB D+/− pair is included in the cable
- If DUT has shorted USB2.0 pins routed to mux or similar, then choose cable Two: In order to enable electrical cable flip in cases where USB D+ lines and USB D- lines correspondingly have not been shorted together on Device side, both USB D+/− pairs are included in the cable. This cable marked with a label “2xUSB 2.0 PAIRS”.

**USB Communication Capable**

You can control the *USB Communication Capable* bit in the sink and source PDO message with the controls in this section.

**PD Controller Reset**

In the event that PD communication between the TE and the DUT gets corrupted the devices might end into a state out of which the devices cannot recover. In order to not have to cycle power to the devices you can apply the PDC Reset button. In most cases the PD communication will be successfully re-initiated, and the testing can continue.

**Bottom Panel**

The control lights indicate presence of the USB-C connection (Plugged, Not Plugged), the type of cable (Passive, Active/E-marked, Unigraf electrical test cable) and Cable Orientation (Straight, Flipped).

With the buttons, you can Connect / Disconnect or Reconnect the USB-C connection.
Edit PDO Information Tab

The *Edit PDO Information* tab is divided into two sub-tabs: PD Source objects and PD Sink objects. Both panels allow user to set the PD Contract parameters of UCD-340 TE.
Power Load

The **Power Load** tab allows user to configure the current consumed from VBUS when UCD-340 acts as PD Sink. The control is done by selecting used load resistance. Different resistance values are available in UCD-340 main unit and in *Unigraf External USB-C Power Test Unit*.

![Power Load Tab](image)

Please see UCD-340 Vbus voltage source capability in the table below. Without *Unigraf External USB-C Power Test Unit* UCD-340 is able to source only 5 V.

<table>
<thead>
<tr>
<th>Vbus power source capability</th>
<th>5 V</th>
<th>9 V</th>
<th>12 V</th>
<th>15 V</th>
<th>20 V</th>
</tr>
</thead>
<tbody>
<tr>
<td>UCD-340</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>UCD-340 with Eternal Power Test Unit</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>

**Note:** Please note that the controls in **Power Load** tab do not allow user to violate USB power delivery specifications.

**Note:** Please note that by using **Power Load** tab settings the user can violate the Power Delivery Options selections made in **Edit PDO information** tab.
Cable Info Tab

The **Cable Info** tab allows user to monitor the VDOs provided by the connected USB-C cable to Discover Identity command.

Click **Refresh** to read the data from an electrically marked cable.

**Note**

Please note that only the port partner that is DFP mode communicates with the cable plug. Therefore, Cable Info is available only in DFP mode.

**Note**

Please note that Cable Info function is not available for some early versions of UCD-340 test equipment hardware. Please contact Unigraf for details.
The USB-C, DP Alt Mode Reference Sink role (DP RX) vertical tab can be seen on the left edge of the GUI.

The horizontal tabs on the top of the GUI enable the various functions available for the input channel. Some of the tabs are enabled by default, some only when an applicable license is included. DPRX features the following functions:

- Video preview and saving (Video). *Enabled by default.*
- Audio monitoring and saving (Audio). *Enabled by default.*
- Status information and control of the upstream link (Link). *Partly enabled by default.*
- EDID editor (EDID).
- DPCD editor (DPCD).
- HDCP status monitor and control (HDCP).

**Video Tab**

![Video Tab Image]

Video tab is the Preview window for the captured DisplayPort stream.

**Input video mode**

4096x2160p 60.0Hz RGB 8bpc Capturing... 1162

The measured input resolution, frame rate and color format is shown below the preview window. The indication of the number of frames captured to the PC shows you the pace of the image data transfer to the PC.

**Disable / Enable Preview**

Click here the button to start or stop capturing video frames.
The top ribbon of the tab has the following controls:

**Color mode for preview**

- **No Conversion**: The captured color components are interpreted as R, G and B respectively. No color conversion will be done.
- **Automatic**: The color mode is selected based on the information in the MSA. If there is no color information available, “No Conversion” is used.
- **YCbCr (ITU-709) -> RGB**: The captured data components are interpreted as Y, Cb, and Cr respectively. Color conversion to RGB is done based on ITU-709 standard.
- **SMPTE 170M -> RGB**: The captured data components are interpreted as Y, U, and V respectively. Color conversion to RGB is done based on SMPTE 170M standard.

---

**Save one frame**

Capture and save one video frame as a bitmap file in the PC. The format and storage location can be selected in Tools > Options pull-down menu. The available bitmap formats are PPM, BMP and JPG.

In Tools > Options menu you can define if the frame bitmap will be stored as captured from the display interface or if the color mode conversion selected for preview will be applied.

**Sequence recording**

Clicking the button opens a dialog where you can enter the number of frames that you want to record. You can also enable the buffered mode in this dialog.

In buffered mode, all input frames are captured non-drop until the on-board frame buffer will be full. E.g. for Full HD (1920×1080) input 242 frames and for UHD 3840×2160 input 64 frames can be stored.

In non-buffered mode, only one input frame is buffered at a time. Frames will be skipped if the transfer of the data to the PC is slower than the input data rate.
Snap preview

You can snap one frame of the incoming video and view it in the GUI. To snap, click the “camera” icon. A preview of the snapped frame will be shown.

You can save the captured bitmap with the **Save one frame** function described above.

You can evaluate the **Color Information of the Captured Bitmap** by placing the mouse cursor on top of it. On the lower right-hand side ribbon of the GUI you can find

- Location of the cross cursor on the bitmap
- The intensity of the Red, Green and Blue components of the pixel on the cursor location
- The HTML color code of the pixel on cursor location

You can set the **Zoom of the Preview Image** by right clicking on top of the preview image and selecting between

- Fit to window
- Zoom 25%
- Zoom 50%
- Zoom 100%
- Zoom 200%
- Zoom 500%

While in the **Snap preview mode** click on the “Camera” icon to take additional snapshots

You can swap between the **Live Preview Mode** and **Snap Preview Mode** by choosing between the **Live** and the **Snapshot** tabs.
Audio tab is enabled by default. Audio tab has a preview of the audio signal format and the controls for audio playback and recording.

The audio signal format is shown in three ways:

- The ‘oscilloscope’ panel displays the waveforms of the received audio channels.
- The frequency spectrum of the audio is shown in the lower panel. The range of the spectrum display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the spectrum display can be selected between ‘Linear’ to 80 dB.

The span of the preview window is defined with Audio preview size found in Tools > Options dialog. The value is given in ksamples (1024 samples). The relation between the preview window span in milliseconds (msec) and the value given in Audio preview size depends on the sampling frequency. Please do not exceed the Audio buffer size set in the same dialog.

**Disable / Enable Preview**

Use this button to control capturing the audio data.
Playback device selection

You can enable audio playback in your PC by selecting the **Playback** check-box. Use the combo-box to select the audio device in the host PC through which the captured audio is played. By default, the **Default Audio** device of your PC is chosen. Please **Disable Preview** in order to make changes.

![UCD-340 (168x214) - USB Type-C Reference Sink](image)

**Note**

Please note that the audio capabilities of the audio playback device of your PC are not automatically reflected in the audio capabilities description in UCD-340 EDID. Since UCD-340 is not performing any audio format conversion, it might occur that the source provides an audio format that the selected playback device is not supporting. In case a conflict occurs, please change manually the EDID content or disable audio playback to monitor the waveforms in UCD Console.

**Refresh audio device list**

![Refresh](image)

Click here to re-read the list of audio devices after making changes to the host PC configuration.

**Audio Buffer Size**

You can define the amount of buffering used in the data transfer between the UCD-340 unit and the PC. **Audio buffer size** can be found in Tools > Options dialog. Increased buffer size will ensure a smooth audio output, but will also increase the delay between the capture of the audio stream and its playback.

**Start audio recording**

![Start](image)

Clicking the button, you can start or stop recording the captured audio in the PC using Waveform Audio File Format, WAV (*.wav) format. In the pop-up dialog, you can define the recording duration. The folder where the audio file will be saved can be selected in File > Options.

![Recording](image)

**Input audio mode**

2 channels; 48000 Hz; 16 bits

This field (in the bottom of the dialog) indicates detected audio mode in the input stream.
Link Tab

Link tab is partly enabled by default, partly with license:

Link tab contains four panels: Cable / HPD, Link Status, Link Configuration and Stream Status.

Cable / HPD
Indicator lights of the state of the cable. Cable indicates that the hardware has detected an upstream cable. HPD indicates that the HPD signal is asserted, logical “high”.

Clicking the Deassert button will cause HPD line to be set to logical “low” (de-asserted) and hence no HPD pulse can be generated. Click the Assert to re-activate the HPD line (set to logical “high”).

To apply an HPD Pulse with programmable duration click Pulse HPD. The duration will be defined in the provided field.

For applying a short pulse click Short Pulse. Pulse duration is 1 ms.

Link Status
Link Status displays the status of the link training and the link parameters negotiated between UCD-340 DisplayPort Alt Mode Sink and the Upstream Source. The data is retrieved from the DPCD registers of the UCD-340 Sink. The status is updated automatically.

Link Configuration
Link Configuration allows the user to change the way the Sink capabilities are announced in the DPCD registers of the UCD-340 DisplayPort Alt Mode Sink. Maximum Lane Count and Maximum Link Rate are set with their appropriate radio buttons.

To update the new status to the DPCD registers click Apply.

To apply a Hot Plug Detect pulse automatically after updating the status, select Generate HPD pulse on Apply. HPD pulse duration will be defined in the Pulse HPD field.
Stream Status

Stream status is enabled with *UCD Pro for DP Sink* license.

Video Timing Details are retrieved from the Main Stream Attributes (MSA) of the monitored stream. Frame rate is calculated by the local sink.

Note: Please note that the MSA information used for Video Timing Details is provided by the Upstream Source, it is not measured by the UCD-340 local DisplayPort Alt Mode Sink.

The 16-bit CRC values of the three-color components is calculated by the Sink hardware. To re-calculate, click **Update Link Status**.
EDID Tab

EDID Tab is enabled with *UCD Console Pro* license.

This tab provides tools for accessing the EDID of the UCD-340 DisplayPort Alt Mode Sink presented to the Upstream Source Device. There are three basic functions:

- Load and save EDID data files in the host PC
- Edit the EDID contents
- Program and read the contents of the hardware EDID memory

**EDID Files**

With **Load...** and **Save as...** you can read and write a hex EDID file from your PC. Please note that the program does not alter the contents of the EDID file or verify its integrity during load and save operation.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Four blocks (512 bytes) of EDID code is read. If the device is not supporting all four blocks, the non-supported area is replaced with zeroes.</td>
</tr>
</tbody>
</table>

Currently the EDID Editor does not support Display ID. You can however modify hex EDID files with the HEX Editor or load and program externally generated hex EDID files that have Display ID content.

**HEX Editor**

When EDID content is either loaded from a file or read from the hardware EDID memory, it is shown in the *EDID Data* panel on the left-hand side of the dialog. You can edit the EDID contents by typing over the existing values. The altered content is highlighted with **RED**. Please note that Hex Editor itself does not alter the contents of the EDID data or verify its integrity.

Once you are done with editing the data, you can either save it to an *.ecd* file in your PC with **Save as...** or program it to the hardware EDID memory with **Write**.
EDID Editor
You can edit the EDID structures of the data in the HEX Editor by clicking EDID Editor. EDID Editor is launched in a separate pop-up window. Please see the description of the EDID editor in Chapter EDID Editor later in this document.
DPCD Tab

The DPCD tab is enabled with *UCD Console Pro* license.

DPCD tab is a tool for monitoring and editing the DPCD registers of the UCD-340 DisplayPort Alt Mode Sink.

The tool consists of two independent monitoring and editing windows for the DPCD data. The user can freely select the the DPCD address areas shown on each panel.

The *DPCD Decoder* panel on the right hand side shows the interpretation of the DPCD byte selected on the monitoring windows. The selected byte is shown with a green outline.

In the combo box above the DPCD Decoder window you can select how the DPCD data is interpreted, either as *DP 1.1 DPCD*, or as *DP 1.2 DPCD* with *Detailed Capability Info* selected or not (DETAILED_CAP_INFO_AVAIL = 1/0).

By clicking **Refresh** you can re-read the data from the DPCD registers to the window in question.

By clicking **Write Changes** you can write the portion of data shown in the window in question to the DPCD registers.

By clicking **Set Reference** you can store currently shown data as a reference for comparison.

When you refresh the data from the DPCD registers the changed bytes will be highlighted with gray background.
The fields edited by the user will be highlighted with red color.

### Saving and Loading DPCD Content

You can save the DPCD data in the address areas that you selected for the two windows as a file in your PC. You can save the content in three alternative formats:

- **Binary DPCD Data File format (*.DPD)**. This is Unigraf proprietary format. You can also load the DPCD content stored in this format.
- **Comma Separated Values (*.CSV)** for loading the data to a spreadsheet.
- **HEX Dump (*.HEX)** in a human readable text format.

- By Clicking **Save** you will be able to select the location and the format of the file.
- By Clicking **Load** you can load DPCD data saved in **DPCD Data File (*.DPD)** format to the editor.
- To program the data into the DPCD registers of UCD-340 local DisplayPort Alt Mode Sink click **Write Changes**.

---

**Note**

- Writing DPCD data to the DPCD registers of the UCD-340 local DisplayPort Alt Mode Sink will potentially affect the status and capabilities of UCD-340 DisplayPort Alt Mode Sink as seen by the upstream DisplayPort Alt Mode Source.
- User control like Link Training or mode changes will modify the content of the DPCD registers.
- During a reboot of UCD-340 the DPCD registers will be returned to their default values.
HDCP Tab

HDCP tab is enabled with *UCD Console Pro* license.

HDCP tab is the dialog for monitoring the HDCP (for *High-Bandwidth Digital Content Protection*) status and controlling the HDCP capabilities of the connected UCD-340 device.

**Status**
The status field indicates the HDCP status of the connected UCD-340 device.

*Active*: The link between UCD-340 and the upstream source has been encrypted.

*Authenticated*: The HDCP handshake between the UCD-340 and the sink unit has been completed successfully.

*Declared as HDCP capable*: The UCD-340 unit recognizes HDCP handshake messages.

*Keys loaded*: The HDCP keys are loaded to the UCD-340 unit.

**Configuration**
*HDCP Capable*: To disable HDCP uncheck the box.

**Keys**
You can select if you are using *Production* or *Facsimile* HDCP keys. To remove the keys, select *None*. 
HDCP 1.3 vs. HDCP 2.3
UCD-340 devices support by default HDCP 1.3 standard with DisplayPort. The functionality supporting HDCP 2.3 is enabled with HDCP 2.3 Support license.
SDP Tab is enabled with *UCD Pro for DP Sink* license.

In SDP Tab you will be able to monitor the *Secondary-Data Packets* sent by the Source device. Click **Update** to re-read the data.

SDP Tab displays in hexadecimal format the following received SDP packets:

- Audio_TimeStamp
- Audio_Stream
- Extension
- Audio_CopyManagement
- ISRC
- Video Stream Configuration (VSC)
- Camera Generic 0
- Camera Generic 1
- Camera Generic 2
- Camera Generic 3
- Camera Generic 4
- Camera Generic 5
- Camera Generic 6
- Camera Generic 7
- Vendor-Specific InfoFrame packet
- AVI InfoFrame packet
- Source Product Descriptor InfoFrame packet
- Audio InfoFrame packet
- MPEG Source InfoFrame packet
- Dynamic Range and Mastering InfoFrame
- Picture Parameter Set (PPS)
Source DUT Testing Tab

Source DUT Testing Tab is enabled with UCD Console Pro license. Please refer to Appendix B of this document for more information about the available tests. Source DUT Testing enables the execution of HDCP 2.3 Compliance Tests for a DP Source DUT.

Source DUT Testing enables testing of a USB-C DP Alt Mode Source DUT. Please refer to Appendix E of this document to get a full definition of the Test Cases and test parameters.

Select the tests for execution by clicking the selector □ in the left hand side of the corresponding row.

Clicking Configure... opens a dialog for defining the test parameters for the test set. Please refer to Test Parameters below for description.

You can also load parameters from Test descriptor files with Import and store them with Export. Please refer to documentation of TSI software API for description.

Run the tests by clicking Run Selected. By clicking Abort you can stop the sequence.

You can control the test flow either with Repeats of the test sequence, Delay between individual tests or Stop on Failure that stops the whole sequence if one of the tests fail.

At the completion of each test the result of the test is indicated in the matrix on the right hand side of the test panel. For each test the matrix lists the number of occurrences of each result and the number of tries performed.

Click Save Report to generate a HTML report file for sharing the results with other parties for viewing without UCD Console.

By clicking Clear All you can clear all results – the test log and the results matrix.

Click Clear Results to clear the result panel.
Test Parameters

Each test set has its dedicated set of test parameters. You can open a dialog for defining the parameters by clicking **Configure**.

Parameters of Electrical Test Group

Each test in the Electrical test set uses parameters to control test execution and acceptance criteria. Parameters for all tests are collected in the dialog **Electrical test parameters**.

HDCP CTS Test Set

The HDCP Tests have test timeout and some additional parameters.
Parameters of CRC Test Set

CRC Video test parameters dialog allows you to define the test duration, number of frames captured, and errors allowed. It allows you to define the frame size and capture.

Click *Capture now* to record *Reference CRCs*. Please define the number of frames used as reference – either one or the number of frames in the predefined test sequence.

**Presets**

In both dialogs you can save the selected parameters as Presets. Please click *Presets…* to save your configuration. If you have saved configuration Presets, you can load one of the saved ones, save a new Preset or delete a Preset.
9. DP ALT MODE REFERENCE SOURCE

The USB-C, DP Alt Mode Reference Source role vertical tab (DP TX) can be seen on the left edge of the GUI.

The horizontal tabs on the top of the GUI enable the various functions available for the output channel. Some of the tabs are enabled by default, some only when an applicable license is included. DPTX features the following functions.

- Video pattern generator (Pattern Generator). *Enabled by default.*
- Status information and control of the downstream link (Link). *Enabled by default.*
- EDID editor (EDID).
- DPCD monitor (DPCD)
- HDCP status monitor and control (HDCP).

Pattern Generator Tab

Predefined Timings
UCD-340 includes a set of common predefined video timings. Please find a list of the timings with their major details in Appendix C: Predefined Timings. Click Select to choose the video timing used.

Color Mode
RGB color mode with full range quantization levels will be used with all patterns except with Color Square Pattern. This pattern allows the user to select RGB, YCbCr 4:4:4, YCbCr 4:2:2 color mode. When YCbCr is selected, the Colorimetry dropdown box is enabled and allows selection between ITU-709 and ITU-601. Please find a description of the available test patterns in Appendix D of this document.

Color Depth
You can set the color depth used. The available color depths are: 18, 24, 30, 36 and 48 bpp.
Predefined Video Patterns
UCD-340 has a set of predefined patterns and a possibility to user defined custom pattern. You can select the pattern in the provided combo box. By selecting Disabled you can have the links activated but no video data transferred.

Please find a description of the available test patterns in Appendix D of this document.

You can use BMP, PNG, JPG and TIFF files in your PC as custom images. The bitmaps will be aligned to the top left-hand side corner, displayed at the original resolution, no scaling, cropped to the active area.

Custom Timing
Custom Timing feature is enabled with UCD Console Pro license.

![Image of UCD-340 GUI showing Video-Pattern Generator and Custom Image settings]

You can modify the timing parameters of the predefined video modes by selecting the Custom check-box and editing the fields of the matrix.

Pattern Generator Settings
In order to avoid sourcing invalid video mode combinations, the new settings need to be validated by the user by clicking Apply. Automatic validation will be applied when Auto-apply when valid is checked.

| Note | Please note that the changes in Pattern Generator tab will not be applied unless the user validates them by clicking Apply or when Auto-apply when valid is checked. |

40.
Manage Timings

Custom timings can also be created and edited with pop-up Timing Editor. You can launch the editor by clicking Manage Timings.

In order to create a new custom timing based on one of the standard fixed timings, select the fixed timing and change its name and click Add new timing to store.

In order to modify an existing custom timing, select it, modify and click Update timing. The dialog will make a sanity check for the values entered and will warn the user for any combinations that cannot be used.

Customize Timings List

You can select which timings are shown on the pull-down menu. If you would like to narrow down the selection un-check the Show box. The timings will remain in the list and can be brought back to the pull-down menu, when needed.
Audio Generator Tab

Audio Generator tab is enabled by default.

Audio generator allows the user to play LPCM audio generated internally or from files in WAV format.

- To load internally generated audio, select Generate audio, and adjust the controls to the desired audio format.

- To load an audio file from your PC, select Load audio from file, click the Open WAV file… button, browse and select the file and click Open

- To play the selected audio content, click the Play button.

The content will be looped until the Stop button is clicked.

Audio Status in the top of the tab indicates the type of the currently played audio content.
Link Tab

Link tab is enabled by default.

The Link tab shows the status and control items for the DP Alt Mode link.

HPD
The status LED indicates the state of the HPD signal Asserted (logical “high”) or De-asserted (logical “low”).

Link status
The panel shows the result of the link training with the connected downstream sink.

Link configuration
You can set the capabilities of the DisplayPort source in the link training:

- Set the Number of Lanes used,
- Set the maximum Link Rate,
- Enable Enhanced Framing Mode

Link Pattern
Select between Active video and audio, Idle pattern or special bit patterns.

CRC
The 16-bit CRC (checksum, cyclic redundancy check) values of the three color components calculated by the Sink hardware.
EDID Tab

EDID tab is enabled with *UCD Console Pro* license.

EDID tab will enable analyzing and saving the EDID read from the connected Sink device.

There are three basic functions:

- Read the contents of the EDID of the downstream sink over the DisplayPort link.
- Load and save EDID data files in the host PC
- Edit the EDID contents

**EDID Files**

With **Load...** and **Save as...** you can read and write a hex EDID file from your PC. Please note that the program does not alter the contents of the EDID file or verify its integrity during load and save operation.

<table>
<thead>
<tr>
<th>Note</th>
<th>Currently the EDID Editor does not support Display ID. You can however modify hex EDID files with the HEX Editor or load and program externally generated hex EDID files that have Display ID content.</th>
</tr>
</thead>
</table>

**HEX Editor**

When EDID content is either loaded from a file or read from the hardware EDID memory, it is shown in the *EDID Data* panel on the left-hand side of the dialog. You can edit the EDID contents by typing over the existing values. The altered content is highlighted with **RED**. Please note that Hex Editor itself does not alter the contents of the EDID data or verify its integrity.

Once you are done with editing the data, you can either save it to an *.ecd* file in your PC with **Save as...** or program it to the hardware EDID memory with **Write**.
EDID Editor

You can edit the EDID structures of the data in the **HEX Editor** by clicking **EDID Editor**. EDID Editor is launched in a separate pop-up window. Please see the description of the EDID editor in Chapter **EDID Editor** later in this document.
DPCD Tab

The DPCD tab is enabled with *UCD Pro for DP Source* license.

DPCD tab is a tool for monitoring and editing the DPCD registers of the connected Downstream Sink.

The tool consists of two independent monitoring and editing windows for the DPCD data. The user can freely select the the DPCD address areas shown on each panel.

The *DPCD Decoder* panel on the right hand side shows the interpretation of the DPCD byte selected on the monitoring windows. The selected byte is shown with a green outline.

In the combo box above the DPCD Decoder window you can select how the DPCD data is interpreted, either as *DP 1.1 DPCD*, or as *DP 1.2 DPCD* with Detailed Capability Info selected or not (DETAILED_CAP_INFO_AVAIL = 1/0).

By clicking **Refresh** you can re-read the data from the DPCD registers to the window in question.

By clicking **Write Changes** you can write the portion of data shown in the window in question to the DPCD registers.

By clicking **Set Reference** you can store currently shown data as a reference for comparison.

When you refresh the data from the DPCD registers the changed bytes will be highlighted with gray background.
The fields edited by the user will be highlighted with red color.

Saving and Loading DPCD Content
You can save the DPCD data in the address areas that you selected for the two windows as a file in your PC. You can save the content in three alternative formats:

- **Binary DPCD Data File** format (*.DPD). This is Unigraf proprietary format. You can also load the DPCD content stored in this format.
- **Comma Separated Values** (*.CSV) for loading the data to a spreadsheet.
- **HEX Dump** (*.HEX) in a human readable text format.

- By Clicking **Save** you will be able to select the location and the format of the file.
- By Clicking **Load** you can load DPCD data saved in **DPCD Data File** (*.DPD) format to the editor.
- In order to program the data into the DPCD registers of UCD-340 local DisplayPort Alt Mode Sink click **Write Changes**.

Note
- Writing DPCD data to the DPCD registers of the Sink will potentially affect the status and capabilities of sink as seen by the source.
- User control like Link Training or mode changes will modify the content of the DPCD registers
HDCP tab is enabled with *UCD Console Pro* license.

HDCP tab is the dialog for monitoring the HDCP (for *High-Bandwith Digital Content Protection*) status and controlling the HDCP capabilities of the connected UCD-340 device.

**Status**

The status field indicate the HDCP status of the connected UCD-340 device.

*Active*: The stream between UCD-340 and the downstream sink has been encrypted.

*Authenticated*: The HDCP handshake between the UCD-340 and the sink unit has been completed successfully.

*Authentication in process*: The HDCP handshake is in process between the UCD-340 and the downstream sink unit.

*Keys loaded*: The HDCP keys are loaded to the UCD-340 unit.

**Configuration**

*Authenticate*: Perform the HDCP initiation handshake between the UCD-340 and the sink unit.

*Enable encryption*: Check to enable the encryption of the stream between UCD-340 and the downstream sink.

**Keys**

You can select if you are using *Production or Facsimile* HDCP keys. To remove the keys, select *None*. 
HDCP 1.3 vs. HDCP 2.3

UCD-340 devices support by default HDCP 1.3 standard with DisplayPort. The functionality supporting HDCP 2.3 is enabled with HDCP 2.3 Support license.
Sink DUT Testing Tab

Sink DUT Testing Tab is enabled with *UCD Console Pro* license. Please refer to **Appendix B** of this document for more information about the available tests. Sink DUT Testing enables the execution of HDCP 2.3 Compliance Tests for a DP Sink DUT.

Sink DUT Testing enables testing of a USB-C DP Alt Mode Sink DUT. Please refer to **Appendix E** of this document to get a full definition of the Test Cases and test parameters.

Select the tests for execution by clicking the the corresponding row.

Clicking **Configure...** opens a dialog for defining the test parameters for the test set. Please refer to **Test Parameters** below for description.

You can also load parameters from *Test descriptor files* with **Import** and store them with **Export**. Please refer to documentation of TSI software API for description.

- Run the tests by clicking **Run Selected**. By clicking **Abort** you can stop the sequence.

You can control the test flow either with **Repeats** of the test sequence, **Delay** between individual tests or **Stop on Failure** that stops the whole sequence if one of the tests fail.

At the completion of each test the result of the test is indicated in the matrix on the right hand side of the test panel. For each test the matrix lists the number of occurrences of each result and the number of tries performed.

Click **Save Report** to generate a HTML report file for sharing the results with other parties for viewing without UCD Console.

By clicking **Clear All** you can clear all results – the test log and the results matrix.

Click **Clear Results** to clear the result panel.
Test Parameters

Each test set has its dedicated set of test parameters. You can open a dialog for defining the parameters by clicking **Configure**.

**Parameters of Electrical Test Group**

Each test in the Electrical test set uses parameters to control test execution and acceptance criteria. Parameters for all tests are collected in the dialog *Electrical test parameters*.

**HDCP CTS Test Set**

The HDCP Tests have test timeout as a given parameter.

**Presets**

In both dialogs you can save the selected parameters as Presets. Please click **Presets** to save your configuration. If you have saved configuration Presets, you can load one of the saved ones, save a new Preset or delete a Preset.

Click **Clear Results** to clear the result panel.
10. EVENT LOG

The Event Logger (Event Log) vertical tab can be seen on the left edge of the GUI. Event Log is enabled with UCD Pro for DP Sink or UCD Pro for DP Source license.

Event Log dialog is divided into three panels: the left panel is for selecting the data to be logged, the center panel lists all logged transactions and the right panel shows the parsed transaction data for the line selected in the list on the left.

With the Event Logger you can capture and evaluate:
- HPD status
- AUX transaction
- DP SDP messages
- Changes in MSA
- Changes in VB-ID
- USB-C PD communication messages

By right-clicking on the transaction list you can select the columns to show on the panel: Time stamps, Type indications, Message source, and raw message data. The right panel lists the content of one message. Messages belonging together with the selected one are shown in red color.
► Start event logging by clicking **Start** and stop it by clicking **Stop**.

► You can save transactions in binary *.evt Event Log files by clicking **Save**. You can recall saved Event Log files by clicking **Open**.

► By clicking **Report** you can store event logs as html reports to be shared and viewed with any web browser. You are first asked to indicate the file name and location, then you can add detailed information about the DUT and the test in free-text **Report information**.

► The saved reports include the same transaction list and parsed message details as when viewing them in the UCD Console GUI.
DP AUX Analyzer functionality is enabled in UCD-340 by UCD Console Pro license.

The AUX Analyzer tabs collect AUX Channel Transactions from the Event Log in the Transaction list. The user can parse the content of each transaction by clicking the corresponding transaction line. The parsed content is in the Message Details panel on the right.

Please refer to chapter Customizing the Main Window below for details on how to modify the content and look of the Transaction list.

Lines

The data is organized in lines, each numbered starting from 1 and marked with a timestamp. There are four kinds of lines:

1. Information lines
   Identified by the text “INFO” in their Type column, they provide some useful information like the time acquisition has started and stopped or the logical state of the inputs, etc.

2. Transaction lines
   Identified by the text “Native” or “I2C” in their Type column, they report an AUX channel data transfer, either a data Request or a data Reply.

3. Event lines
   Identified by the text “Event” in their Type column, they signal the state change in one or more of the monitored inputs.

4. Error lines
   A line Type reading “Error” marks the detection of an illegal AUX channel data packet. An irregular start condition, an irregular stop condition or transfer of a number of bits which is not a multiple of 8 are all conditions that cause an error line.

5. Trace lines
   Combines the data from several lines of a HDCP related message to one entry in Message details panel for easier readability.
Columns

The data on each line is ordered in columns. Each column provides additional information about the data line, facilitating its viewing and interpretation:

**Line**

This column displays the line number, starting from 1, and cannot be hidden.

**Timestamp**

Each line is identified by its timestamp, marking the instant when an event or error was detected, or when a data transaction got started. The timestamp can be displayed as a time delay from the start of the acquisition (absolute) or from the previous line (relative). The timestamp can be displayed in milliseconds or in minutes, seconds and microseconds.

**From**

This column indicates the originator of the data line:

- “Source” and “Sink” for an AUX channel transaction, respectively a data Request and a data Reply.
- “UCD” for error and information lines.
- “Unknown” for signal state change events.

**Type**

This column provides additional information about the type of the line:

- “Native” marks Native AUX channel Requests and Replies.
- “I2C” marks I2C AUX channel Requests and Replies.
- “INFO” is used with information lines.
- “Error” is used for illegal conditions detected on the AUX channel.

**Details**

This column contains an abbreviated description of the line content in textual form.

**Data**

The binary data exchanged during AUX channel transactions, in hexadecimal notation.

**Message Details**

The Message details panel is used to provide a detailed explanation of the line currently selected in the Transaction list. For AUX channel transaction lines, for each of the DPCD memory locations affected, the panel lists:

- All data bytes read or written.
- All DPCD memory locations affected.
- The name of the locations and of each of their bit fields.
- All bit field’s numeric and binary values, together with their decoded value.
- The Replies outcome (AUX_ACK, AUX_NACK, I2C_DEFER, etc.).
Customizing the Main Window

You can change the format of the data shown in the Transaction list and the Message details panels in order to highlight the details of your interest.

Selecting Data Columns

You can customize the Transaction list by clicking the right button of your mouse over the list. From the pop-up menu, you can choose which columns to display, the style of the timestamp and switch between absolute and relative timestamps. You can also select Filters to show only part of the transactions in the list. Please see Filtering later in this document.

Selecting Font and Colors

You can select the font style and size used for displaying the Transaction list and the Message details.

Select Tools > Options > AUX Analyzer options tab. Click Select new font and choose the font and size that you want to use.
Transaction List Color Options
You can select the colors for the font and background of various items.

Highlighted DPCD Address Ranges
In order to improve the readability of the Transaction list, you can mark the AUX channel transactions where a certain DPCD register address or address range is highlighted with a color of your choice.

Click Add…, select the access type, start DPCD address and end DPCD address of the range in Hex. Press Accept.

Select the range you just created from the Highlighted DPCD addresses ranges list and click the Change test color and Change background color buttons to select the colors desired.

You can create multiple simultaneous coloring rules to help you get a better view of the data captured.
Filtering

You can select which transactions lines are shown in the transaction list by Filtering. You can choose the data based on:

- The type of data line
- The origin of the message
- The DPCD address range

Right click > Filters drop down menu you can find by default a set of pre-programmed filters.

Editing Filters

From Custom Filter dialog (Tools > Options > Edit Custom Filters …) provides you a possibility to add and modify filters. The pre-programmed filters are listed in the dialog. You can copy their structure as bases of your custom filters. It is advisable not to modify the pre-programmed filters directly but make copies of them.

In the Stored custom filter definitions panel, you will have the list of currently defined Filters. On the right hand side buttons, you can define new Filters, rename or delete them. You can also reorder their appearance in the Filters pull-down menu.

In the Filter Rules panel lower in the dialog you can review and change the Rules in the selected Filter. By clicking Add… you can create new rules, clicking Edit… you can review and edit existing Filters and by clicking Remove from the Filter definition.
When you click Add… or Edit… *Edit Filter Rule* dialog opens. In the dialog you can in detail define the action of the rule, select the event and the event details.

You can get help by clicking **Help**. The “Help” text is attached to Appendix F of this document.

<table>
<thead>
<tr>
<th>Note</th>
<th>Please note that Filters are a very powerful tool. They can however unintentionally hide valuable data from you. Please be careful when applying custom filters. A good practice is to start from an existing filter and gradually add new rules while testing their performance.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>Filtering and selecting the columns for display do not affect the actual data acquisition. All transactions and their full data are always captured.</td>
</tr>
</tbody>
</table>
11. EDID EDITOR

The Main Window

The EDID Editor main window is divided into three logical areas. The bottom part of the window contains the command buttons, and the log view. The top-left portion shows the currently edited E-EDID blocks in a tree-form, and the top-right portion shows an edit control for the currently selected item, possibly a list of sub-keys and their names (The list is not shown for all values) and the HEX-view of the block collection.

Command Buttons

- **Load**: Load an EDID block collection file from disk.
- **Save**: Save the current block collection to a disk file.
- **Show Hex**: Show or Hide the HEX view.
- **Show Log**: Show or Hide the Log view.

EDID Editor Features

The EDID Editor currently supports VESA E-EDID block versions 1.3 and 1.4. As the standard defines, the versions 1.0, 1.1 and 1.2 are supposed to be backward compatible, and therefore the VESA E-EDID decoder will also show their contents. However, in these cases it should be noted that the error checking is not compliant with restrictions given in these older versions of the standard. In addition to VESA E-EDID block, the CEA-861 versions 1, 2 and 3 EDID blocks are also fully supported as well as the VESA Block Map Extension blocks.

Practically unlimited number of extension blocks may exist in a single collection. The number of blocks is limited by VESA Specifications and possibly by available system resources. Most EDID blocks contain a structure that is very similar to a tree-structure. The EDID Editor decodes each block into a tree-view of the block. The tree-view then contains all values contained within the EDID block. The contents can then be easily browsed, using only a few mouse clicks. The EDID Editor has a support for automatic variables, such as the block checksum. When the user changes a value in an EDID block, the tool will update the checksum accordingly. The automatic variables appear as read only values for the user. A log print will be made when an automatic variable is updated by the editor.

**HEX View**: An optional HEX data display of all blocks in the collection. The view also shows the latest changes highlighted.
LOG View: An optional LOG view, which will contain log prints generated by the editor. Mostly it will list values that have been automatically updated due to edits.

Editing Tips

Editing an EDID block is very straightforward, but there are some special cases where the user must know how to accomplish certain types of tasks.

- **Enter** key will apply text-edit values and combo-box selection.
- To apply new setting to *binary* values (ones that show a check-box), please click the **Set** button.
- When you see a **Quick Config** button appear below an editor, you can access a configuration menu that allows you to quickly select one of multiple pre-defined setup options.
- In CEA-861 blocks, you can add and remove 18-byte descriptors and CEA data blocks by setting the values “18-byte Descriptors in this block” and “CEA Data block count”. Unfortunately re-arranging the descriptors and CEA data blocks is not supported yet, so you need to be careful when editing these.
- Enter hex values with prefix “0x” or “$”, no prefix means a decimal value.
- You can always enter HEX or DEC, even if the value is presented as HEX, and/or value range is given in HEX.
- Floating point values must be given with period “.” as decimal separator, even if your localization setting defines decimal separator as comma (or other).
- Remember to click **Set** after changing a bit-value presented as a single check-box if you want the new value applied.

**Note**

It is recommended that you back up the un-edited EDID contents to a file before editing and writing it to the card.

Saving EDID Data

When you are done with editing you can either save the EDID contents to a file in the PC or bring it in the HEX Editor.

For saving the data to a file in your PC click **Save**.

For bringing the data to the HEX Editor close the EDID Editor window by clicking the **Window Close** button in the top right-hand corner of the window. You will be asked if you would like to copy and replace the EDID data in the HEX Editor. Click **Yes** to replace the data, click **No** to discard the modifications.

When you are back in the HEX Editor, the bytes that the EDID Editor changed are highlighted with **BLUE BACKGROUND**.
**APPENDIX A. PRODUCT SPECIFICATION**

**UCD-340**

<table>
<thead>
<tr>
<th>Test Connections</th>
<th>USB Type-C (Dual Role Port)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>USB Type-A (test signal Device)</td>
</tr>
<tr>
<td></td>
<td>pass-thru</td>
</tr>
<tr>
<td></td>
<td>USB Type-B (Host) pass-thru</td>
</tr>
<tr>
<td></td>
<td>External Power Source / Sink connector</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DP Alt Mode</th>
<th>Resolution up to 4096x2160p60</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Up to HBR2 rate in up to 4 lanes</td>
</tr>
<tr>
<td></td>
<td>Color depth up to 48 bits</td>
</tr>
<tr>
<td></td>
<td>Support HDCP 1.3 and 2.3</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>USB Over USB-C</th>
<th>USB 3.1 Gen1 (5 Gbps) and USB 2.0 pass-thru</th>
</tr>
</thead>
</table>

| USB Power Delivery        | Sink and source 5 V up to 3.0 A, up to 20 V / 5 A with external power test unit (Optional) |

| Electrical Test           | Verify voltage current flow in USB Type-C interface signals (VBUS, GROUND, CC1/2, SBU1/2). (Optional) |

| Computer interface        | USB 3.0 and USB 2.0 |

<table>
<thead>
<tr>
<th>Software</th>
<th>Windows 10, 8 and 7 compatible software driver</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>UCD Console application for Windows</td>
</tr>
<tr>
<td></td>
<td>TSI API with ready Test Cases</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power supply</th>
<th>AC/DC Power supply</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>(100 to 240 Vac 50/60 Hz input, +12 Vdc output)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mechanical Size</th>
<th>281 × 128 × 62 mm</th>
</tr>
</thead>
</table>

| Weight                    | 0.9 kg w/o power supply |

All specifications are subject to change without notice.
APPENDIX B. LICENSING

Please find detailed explanation of the functions and the licensing for *UCD Console GUI* and *TSI software API*.

### Features Available in UCD-340 Default Feature Set

<table>
<thead>
<tr>
<th>Feature Available in UCD Consol</th>
<th>Feature available in TSI SDK and API</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USB-C Modes Common</strong></td>
<td></td>
</tr>
<tr>
<td>USB-C Data Role status</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>USB-C Power Role status</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>USB-C Vbus / CC / Vconn voltage / current monitoring*</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>Support for USB-C External Power Unit</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td><strong>DP Alt Mode Common</strong></td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>USB-C DP ALT Mode status</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>USB-C DP ALT Mode control</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>DP Link Status Information</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>Support for Electrical Test option and Cable*</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>Orientation Test with Electrical Test Cable*</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Sink</strong></td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>DP Alt Mode capture, preview and saving</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>TSI Video test (software pixel comparison)</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>TSI Audio test</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Source</strong></td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>Video Pattern Generator (Fixed Patterns and Timings)</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>Audio Generator</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td><strong>Testing HDCP</strong></td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>HDCP preview up to HDCP 1.3</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>HDCP status monitor and control up to HDCP 1.3</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>DP HDCP 2.3 CTS for Testing Sink DUT **</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
<tr>
<td>DP HDCP 2.3 CTS for Testing Source DUT **</td>
<td><img src="icon_UNIGRAF.png" alt="Feature available in UCD Console" /> <img src="icon_UNIGRAF.png" alt="Feature available in TSI SDK and API" /></td>
</tr>
</tbody>
</table>

*) Available in model *UCD-340 USB-C DP Alt Mode Tester with Electrical Test*, P/N 066515

**) Available with feature *DP HDCP 2.3 CTS* (Separate for testing Sink and Source DUT)
## Appendix B. Licensing

### UCD-340 Default UCD Console Features

<table>
<thead>
<tr>
<th>Category</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USB-C Modes Common</strong></td>
<td>USB-C Data Role status</td>
<td>Support for USB-C External Power Unit</td>
</tr>
<tr>
<td></td>
<td>USB-C Power Role status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>USB-C Vbus / CC / Vconn voltage / current monitoring</td>
<td></td>
</tr>
<tr>
<td><strong>DP Alt Mode Common</strong></td>
<td>USB-C DP ALT Mode status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>USB-C DP ALT Mode control</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DP Link Status Information</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Support for Electrical Test option and Cable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Orientation Test with Electrical Test Cable</td>
<td></td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Sink</strong></td>
<td>DP Alt Mode capture, preview and saving</td>
<td></td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Source</strong></td>
<td>Video pattern generator (fixed patterns and timings)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Audio Generator</td>
<td></td>
</tr>
<tr>
<td><strong>Testing HDCP</strong></td>
<td>HDCP preview up to HDCP 1.3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>HDCP status monitor and control up to HDCP 1.3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DP HDCP 2.3 CTS for Testing Sink DUT</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DP HDCP 2.3 CTS for Testing Source DUT</td>
<td></td>
</tr>
</tbody>
</table>

### UCD-340 with Console Pro Feature Set

<table>
<thead>
<tr>
<th>Category</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USB-C Modes Common</strong></td>
<td>USB-C Data Role control</td>
<td></td>
</tr>
<tr>
<td></td>
<td>USB-C Power Role status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Power Delivery protocol monitoring</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Event Logger</td>
<td></td>
</tr>
<tr>
<td><strong>DP Alt Mode Common</strong></td>
<td>EDID read / write</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DPCD read / write</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Event Log</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DP AUX Analyzer</td>
<td></td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Sink</strong></td>
<td>Source DUT Testing (Link and CRC test)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TSI Video test (software pixel comparison)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TSI Audio test</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CRC based video test set</td>
<td></td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Source</strong></td>
<td>Custom video patterns and timings</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Monitor SDP</td>
<td></td>
</tr>
<tr>
<td></td>
<td>DP HDCP 2.3 status and control</td>
<td></td>
</tr>
</tbody>
</table>

### Notes

- **Electrical Test**: Available in model UCD-340 USB-C DP Alt Mode Tester with Electrical Test, P/N 066515
- **HDCP 2.3 status and control**: Available with HDCP 2.3 support (P/N MT16504) license
- **HDCP 2.3 CTS**: Available with HDCP 2.3 CTS for testing Source on DP DUT (P/N MT6634) or HDCP 2.3 CTS for testing Sink on DP DUT (P/N MT6636) license
# Features Available in UCD-340 with Console Pro Feature Set

<table>
<thead>
<tr>
<th>Feature Available in UCD</th>
<th>Console Pro for Type-C DP Sink</th>
<th>Console Pro for Type-C DP Source</th>
<th>TSI Advanced*</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USB-C Modes Common</strong></td>
<td>USB-C Data Role Status &amp; Control</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB-C Data Role Status &amp; Control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB-C Power Role status &amp; Control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB-C Vbus / CC / Vconn voltage / current monitoring**</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Power Delivery protocol monitoring</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event Logger</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Support for USB-C External Power Unit</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>DP Alt Mode Common</strong></td>
<td>USB-C DP ALT Mode status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB-C DP ALT Mode status</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>USB-C DP ALT Mode control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EDID read / write</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DPCD read / write</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Event Log</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DP AUX Analyzer</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Support for Electrical Test option and Cable**</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Orientation Test with Electrical Test Cable**</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Sink</strong></td>
<td>DP Link Status Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DP Link Status Information</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DP Alt Mode capture, preview and saving</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Source DUT Testing (Link and CRC test)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TSI Video test (software pixel comparison)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TSI Audio test</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Source</strong></td>
<td>DP Link Status Information</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DP Link Status Information</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Audio Generator</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Control of the downstream link</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Pattern Generator (Fixed Patterns and Timings)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Pattern Generator (Custom Patterns and Timings)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monitor Secondary-Data Packets (SDP)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Testing HDCP</strong></td>
<td>HDCP preview up to HDCP 1.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDCP preview up to HDCP 1.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDCP status monitor and control up to HDCP 1.3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDCP 1.3 Test Key support</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HDCP 2.3 status and control ***</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DP HDCP 2.3 CTS for Testing Sink DUT ****</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>**DP HDCP 2.3 CTS for Testing Source DUT ****</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) TSI Advanced feature is delivered with Console Pro features.

**) Available in model UCD-340 USB-C DP Alt Mode Tester with Electrical Test, P/N 066515

*****) Available with feature HDCP 2.3 Support

****) Available with feature DP HDCP 2.3 CTS (Separate for testing Sink and Source DUT)

- Feature available in UCD Console
- Feature available in TSI SDK and API
## Appendix B. Licensing

### UCD-340 Default TSI API Features

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USB-C Modes Common</strong></td>
<td>USB Data Role status, USB-C Power Role status, USB-C Vbus / CC / Vconn voltage / current monitoring, Support for USB-C External Power Unit</td>
</tr>
<tr>
<td><strong>DP Alt Mode Common</strong></td>
<td>USB-C DP ALT Mode status, DP Link Status Information, Support for Electrical Test option and Cable, Orientation Test with Electrical Test Cable</td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Sink</strong></td>
<td>DP Alt Mode capture and saving, TSI Video test (software pixel comparison), TSI Audio test</td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Source</strong></td>
<td>Video Pattern Generator (Fixed Patterns and Timings)</td>
</tr>
<tr>
<td><strong>Testing HDCP</strong></td>
<td>HDCP status monitor and control up to HDCP 1.3, DP HDCP 2.3 CTS for Testing Sink DUT, DP HDCP 2.3 CTS for Testing Source DUT</td>
</tr>
</tbody>
</table>

### UCD-340 with TSI Advanced Feature Set

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Power Delivery protocol monitoring</strong></td>
<td>Event Logger</td>
</tr>
<tr>
<td><strong>USB-C DP ALT Mode control</strong></td>
<td>EDID read / write, DPCD read / write</td>
</tr>
<tr>
<td><strong>CRC based video test set</strong></td>
<td>Custom video patterns and timings, Monitor SDP</td>
</tr>
<tr>
<td><strong>HDCP 1.3 Test Key support</strong></td>
<td>HDCP 2.3 status and control</td>
</tr>
</tbody>
</table>

### Electrical Test

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Available in model UCD-340 USB-C DP Alt Mode Tester with Electrical Test, P/N 066515</strong></td>
<td></td>
</tr>
<tr>
<td><strong>HDCP 2.3 status and control</strong></td>
<td>Available with HDCP 2.3 support (P/N MT6504) license</td>
</tr>
<tr>
<td><strong>HDCP 2.3 CTS</strong></td>
<td>Available with HDCP 2.3 CTS for testing Source on DP DUT (P/N MT6634) or HDCP 2.3 CTS for testing Sink on DP DUT (P/N MT6636) license</td>
</tr>
</tbody>
</table>
# Appendix B. Licensing

## Features Available in UCD-340 with TSI Advanced Feature Set

<table>
<thead>
<tr>
<th>Feature Available in UCD Console Basic</th>
<th>Feature Available in TSI Advanced</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>USB-C Modes Common</strong></td>
<td>USB-C Data Role status</td>
</tr>
<tr>
<td></td>
<td>USB-C Data Role Control</td>
</tr>
<tr>
<td></td>
<td>USB-C Power Role status</td>
</tr>
<tr>
<td></td>
<td>USB-C Power Role Control</td>
</tr>
<tr>
<td></td>
<td>USB-C Vbus / CC / Vconn voltage / current monitoring*</td>
</tr>
<tr>
<td></td>
<td>Support for USB-C External Power Unit</td>
</tr>
<tr>
<td><strong>DP Alt Mode Common</strong></td>
<td>USB-C DP ALT Mode status</td>
</tr>
<tr>
<td></td>
<td>DP Link Status Information</td>
</tr>
<tr>
<td></td>
<td>USB-C DP ALT Mode control</td>
</tr>
<tr>
<td></td>
<td>EDID read/write</td>
</tr>
<tr>
<td></td>
<td>DPCD read/write</td>
</tr>
<tr>
<td></td>
<td>Support for Electrical Test option and Cable*</td>
</tr>
<tr>
<td></td>
<td>Orientation Test with Electrical Test Cable*</td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Sink</strong></td>
<td>DP Alt Mode capture, preview and saving</td>
</tr>
<tr>
<td></td>
<td>TSI Video test (software pixel comparison)</td>
</tr>
<tr>
<td></td>
<td>TSI Audio test</td>
</tr>
<tr>
<td></td>
<td>CRC based video test set</td>
</tr>
<tr>
<td><strong>DP Alt Mode Reference Source</strong></td>
<td>Control of the downstream link</td>
</tr>
<tr>
<td></td>
<td>Video Pattern Generator (Fixed Patterns and Timings)</td>
</tr>
<tr>
<td></td>
<td>Video Pattern Generator (Custom Patterns and Timings)</td>
</tr>
<tr>
<td></td>
<td>Monitor Secondary-Data Packets (SDP)</td>
</tr>
<tr>
<td><strong>Testing HDCP</strong></td>
<td>HDCP preview up to HDCP 1.3</td>
</tr>
<tr>
<td></td>
<td>HDCP status monitor and control up to HDCP 1.3</td>
</tr>
<tr>
<td></td>
<td>HDCP 2.3 status and control **</td>
</tr>
<tr>
<td></td>
<td>DP HDCP 2.3 CTS for Testing Sink DUT ***</td>
</tr>
<tr>
<td></td>
<td>DP HDCP 2.3 CTS for Testing Source DUT ***</td>
</tr>
</tbody>
</table>

* Available in model UCD-340 USB-C DP Alt Mode Tester with Electrical Test, P/N 066515

**) Available with license TSI Advanced with HDCP 2.3 Support

***) Available with feature DP HDCP 2.3 CTS (Separate for testing Sink and Source DUT)

![Feature Available in UCD Console](image28) ![Feature Available in TSI SDK and API](image29)
# APPENDIX C: PREDEFINED TIMINGS

<table>
<thead>
<tr>
<th>Description</th>
<th>H active</th>
<th>V active</th>
<th>H total</th>
<th>V total</th>
<th>Frame rate</th>
<th>RGB 6 bpc</th>
<th>RGB 8 bpc</th>
<th>RGB 10 bpc</th>
<th>RGB 12 bpc</th>
<th>RGB 16 bpc</th>
</tr>
</thead>
<tbody>
<tr>
<td>VESA 800 x 600 @ 60Hz</td>
<td>800</td>
<td>600</td>
<td>1056</td>
<td>628</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 848 x 480 @ 60Hz</td>
<td>848</td>
<td>480</td>
<td>1088</td>
<td>517</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1024 x 768 @ 60Hz</td>
<td>1024</td>
<td>768</td>
<td>1344</td>
<td>806</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTA 1280 x 720 @ 60Hz</td>
<td>1280</td>
<td>720</td>
<td>1650</td>
<td>750</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1280 x 768 @ 60Hz</td>
<td>1280</td>
<td>768</td>
<td>1684</td>
<td>788</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1280 x 960 @ 60Hz</td>
<td>1280</td>
<td>960</td>
<td>1800</td>
<td>1000</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1280 x 800 @ 60Hz [RB]</td>
<td>1280</td>
<td>800</td>
<td>1440</td>
<td>823</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1280 x 800 @ 60Hz</td>
<td>1280</td>
<td>800</td>
<td>1680</td>
<td>831</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1280 x 768 @ 60Hz</td>
<td>1280</td>
<td>768</td>
<td>1440</td>
<td>790</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1280 x 1024 @ 60Hz</td>
<td>1280</td>
<td>1024</td>
<td>1688</td>
<td>1066</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1360 x 768 @ 60Hz</td>
<td>1360</td>
<td>768</td>
<td>1792</td>
<td>795</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1400 x 1050 @ 60Hz</td>
<td>1400</td>
<td>1050</td>
<td>1560</td>
<td>1080</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1600 x 1200 @ 60Hz [RB]</td>
<td>1600</td>
<td>1200</td>
<td>1760</td>
<td>1235</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1600 x 1200 @ 60Hz</td>
<td>1600</td>
<td>1200</td>
<td>2160</td>
<td>1250</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1680 x 1050 @ 60Hz</td>
<td>1680</td>
<td>1050</td>
<td>2240</td>
<td>1089</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1680 x 1050 @ 60Hz [RB]</td>
<td>1680</td>
<td>1050</td>
<td>1840</td>
<td>1080</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1792 x 1344 @ 60Hz</td>
<td>1792</td>
<td>1344</td>
<td>2448</td>
<td>1394</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1920 x 1080 @ 30Hz [RB1]</td>
<td>1920</td>
<td>1080</td>
<td>2080</td>
<td>1096</td>
<td>30</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1920 x 1080 @ 30Hz [RB2]</td>
<td>1920</td>
<td>1080</td>
<td>2000</td>
<td>1096</td>
<td>30</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTA 1920 x 1080 @ 30Hz</td>
<td>1920</td>
<td>1080</td>
<td>2200</td>
<td>1125</td>
<td>30</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1920 x 1080 @ 60Hz [RB1]</td>
<td>1920</td>
<td>1080</td>
<td>2080</td>
<td>1111</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1920 x 1080 @ 60Hz [RB2]</td>
<td>1920</td>
<td>1080</td>
<td>2000</td>
<td>1111</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTA 1920 x 1080 @ 60Hz</td>
<td>1920</td>
<td>1080</td>
<td>2200</td>
<td>1125</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1920 x 1080 @ 120Hz [RB1]</td>
<td>1920</td>
<td>1080</td>
<td>2080</td>
<td>1144</td>
<td>120</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1920 x 1080 @ 120Hz [RB2]</td>
<td>1920</td>
<td>1080</td>
<td>2000</td>
<td>1144</td>
<td>120</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTA 1920 x 1080 @ 120Hz</td>
<td>1920</td>
<td>1080</td>
<td>2200</td>
<td>1125</td>
<td>120</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 1920 x 1440 @ 60Hz</td>
<td>1920</td>
<td>1440</td>
<td>2600</td>
<td>1500</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 2048 x 1536 @ 60Hz</td>
<td>2048</td>
<td>1536</td>
<td>2208</td>
<td>1580</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 2560 x 1440 @ 60Hz</td>
<td>2560</td>
<td>1440</td>
<td>2720</td>
<td>1481</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 2560 x 1080 @ 60Hz</td>
<td>2560</td>
<td>1080</td>
<td>3424</td>
<td>1120</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 2560 x 1080 @ 60Hz [RB]</td>
<td>2560</td>
<td>1080</td>
<td>2720</td>
<td>1111</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 2560 x 1600 @ 60Hz</td>
<td>2560</td>
<td>1600</td>
<td>3504</td>
<td>1658</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 2560 x 1600 @ 60Hz [RB]</td>
<td>2560</td>
<td>1600</td>
<td>2720</td>
<td>1646</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other 2880 x 1440 @ 60Hz</td>
<td>2880</td>
<td>1440</td>
<td>2976</td>
<td>1456</td>
<td>60</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 4096 x 2160 @ 60Hz</td>
<td>4096</td>
<td>2160</td>
<td>4176</td>
<td>2222</td>
<td>60</td>
<td>● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 3840 x 2160 @ 30Hz [RB1]</td>
<td>3840</td>
<td>2160</td>
<td>4000</td>
<td>2191</td>
<td>30</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 3840 x 2160 @ 30Hz [RB2]</td>
<td>3840</td>
<td>2160</td>
<td>3920</td>
<td>2191</td>
<td>30</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTA 3840 x 2160 @ 30Hz</td>
<td>3840</td>
<td>2160</td>
<td>4400</td>
<td>2250</td>
<td>30</td>
<td>● ● ● ● ● ● ● ● ● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTA 3840 x 2160 @ 50Hz</td>
<td>3840</td>
<td>2160</td>
<td>5280</td>
<td>2250</td>
<td>50</td>
<td>● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTA 4096 x 2160 @ 50Hz</td>
<td>4096</td>
<td>2160</td>
<td>5280</td>
<td>2250</td>
<td>50</td>
<td>● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 3840 x 2160 @ 60Hz [RB1]</td>
<td>3840</td>
<td>2160</td>
<td>4000</td>
<td>2222</td>
<td>60</td>
<td>● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VESA 3840 x 2160 @ 60Hz [RB2]</td>
<td>3840</td>
<td>2160</td>
<td>3920</td>
<td>2222</td>
<td>60</td>
<td>● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTA 3840 x 2160 @ 60Hz</td>
<td>3840</td>
<td>2160</td>
<td>4400</td>
<td>2250</td>
<td>60</td>
<td>● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CTA 4096 x 2160 @ 60Hz</td>
<td>4096</td>
<td>2160</td>
<td>4400</td>
<td>2250</td>
<td>60</td>
<td>● ●</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

● = Supported video mode and color depth (● using 2 lanes, ● using 4 lanes)
## APPENDIX D: PREDEFINED PATTERNS

<table>
<thead>
<tr>
<th>Selection</th>
<th>Pattern</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disabled</td>
<td>N/A</td>
<td>The links are activated but no video data transferred</td>
</tr>
<tr>
<td>Color Bar</td>
<td><img src="image" alt="Color Bar" /></td>
<td>100% intensity color bars of all primaries and mixed combinations.</td>
</tr>
<tr>
<td>Chessboard</td>
<td><img src="image" alt="Chessboard" /></td>
<td>8 by 8 chessboard with black (0%) and 100% intensity white</td>
</tr>
<tr>
<td>Solid Black</td>
<td><img src="image" alt="Solid Black" /></td>
<td>0% luminance</td>
</tr>
<tr>
<td>Solid White</td>
<td><img src="image" alt="Solid White" /></td>
<td>100% white</td>
</tr>
<tr>
<td>Solid Red</td>
<td><img src="image" alt="Solid Red" /></td>
<td>100% red</td>
</tr>
<tr>
<td>Solid Green</td>
<td><img src="image" alt="Solid Green" /></td>
<td>100% green</td>
</tr>
<tr>
<td>Solid Blue</td>
<td><img src="image" alt="Solid Blue" /></td>
<td>100% blue</td>
</tr>
<tr>
<td>White Vertical Stripes</td>
<td><img src="image" alt="White Vertical Stripes" /></td>
<td>Vertical stripes of black (0%) and white (100%). Parameters set the widths of the black and white stripes in pixels respectively. Default black / white = 20 / 20 pixels. Parameter range 0 to 5000.</td>
</tr>
<tr>
<td>Gradient Vertical Stripes</td>
<td><img src="image" alt="Gradient Vertical Stripes" /></td>
<td>16 pixels high horizontal red, green, blue and white stripes. Intensity is increased from 0 to 100% with steps defined by the given parameter (n). (step = n*color_depth/256). &quot;n&quot; range 0 to 5000 (default 120).</td>
</tr>
<tr>
<td>Color Ramp</td>
<td><img src="image" alt="Color Ramp" /></td>
<td>Color Ramp test pattern defined by VESA DisplayPort Link Layer Compliance Test Specification.</td>
</tr>
<tr>
<td>Color Square</td>
<td><img src="image" alt="Color Square" /></td>
<td>Color Square test pattern defined by VESA DisplayPort Link Layer Compliance Test Specification. Color mode can be selected between RGB, YCbCr 4:4:4, 4:2:2, 4:2:0 (ITU Rec 601 / 709)</td>
</tr>
<tr>
<td>Motion Pattern</td>
<td><img src="image" alt="Motion Pattern" /></td>
<td>Horizontally moving color bar pattern. The pattern is shifted to left one pixel in each frame in a sequence. The length of the sequence is defined with parameter. Range 0 to 34 (default is 20)</td>
</tr>
<tr>
<td>Custom Image</td>
<td><img src="image" alt="Custom Image" /></td>
<td>Bitmap image uploaded by the user. Click on the Custom Images panel to browse.</td>
</tr>
</tbody>
</table>

More test patterns can be downloaded e.g. from www.icdm-sid.org/downloads/testpatterns.html.
APPENDIX E: SINK AND SOURCE DUT TESTS


<table>
<thead>
<tr>
<th>Source DUT Testing</th>
<th>Default</th>
<th>Electrical Testing</th>
<th>DP HDCP 2.3 CTS*</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRC based Video Test Set</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>CRC based single frame reference video test (TSI_TEST_VIDEO_CRC_SINGLE_REF)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>CRC based single frame stability test (TSI_TEST_CRC_VIDEO_STABILITY)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>CRC based sequence of frames reference video test (TSI_TEST_CRC_VIDEO_SEQUENCE)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Link Test Set</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Link Training at All Supported Lane Counts and Link Rates (TSI_TEST_DP_SIMPLE_LINK)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>USBC Electrical Test Set</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Up Face Port CC and VCONN test (TSI_TEST_USBC_CC_VCON)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>AUX (SBU) lines test (TSI_TEST_USBC_SBU_DP_AUX)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>DUT as Power Sink (TSI_TEST_USBC_DUT_PWR_SINK)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>DUT as Power Source (TSI_TEST_USBC_DUT_PWR_SOURCE)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>HDCP 2.3 CTS 1A Test Set HCDP2.3 CTS 1A-01 – HCDP2.3 CTS 1A-13</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>HDCP 2.3 CTS 1B Test Set HCDP2.3 CTS 1B-01 – HCDP2.3 CTS 1B-10</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sink DUT Testing</th>
<th>Default</th>
<th>Electrical Testing</th>
<th>DP HDCP 2.3 CTS*</th>
</tr>
</thead>
<tbody>
<tr>
<td>USBC Electrical Test Set</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Up Face Port CC and VCONN test (TSI_TEST_USBC_CC_VCON)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>AUX (SBU) lines test (TSI_TEST_USBC_SBU_DP_AUX)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>DUT as Power Sink (TSI_TEST_USBC_DUT_PWR_SINK)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>DUT as Power Source (TSI_TEST_USBC_DUT_PWR_SOURCE)</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>HDCP 2.3 CTS 2C Test Set HCDP2.3 CTS 2C-01 – HCDP2.3 CTS 2C-06</td>
<td></td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

*) Separate licenses for testing Sink and Source DUT
CRC Based Single Reference Frame Video Test

The test compares captured frames to a provided reference.

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to provided parameters and after that captures frames and compares the CRC (check sum) of their three color components to the provided reference until the number of bad frame limit provided is detected or the provided total number of frames is reached.

The test is judged FAIL if video mode does not match or the number of bad frames is exceeded.

The test optionally captures the failed frames as bitmap images and stores them into the hard disc.

**Parameters in use**

- Test Timeout (default 100 000 ms)
- Total number of frames (default 2 000 ms)
- Number of bad frames allowed (default 2)
- Reference width (default 1920)
- Reference height (default 1080)
- Reference BPP (default 24)
- Expected frame rate (mHz)
- Frame rate tolerance (mHz)
- Reference CRCs (R, G, B)
CRC Based Single Frame Video Stability Test

The test verifies that the captured video is stable. TE captures a frame and sets the CRC of its color components as reference. After that TE captures frames and compares their CRC (check sum) to the reference until the number of bad frame limit provided is detected or the provided total number of frames is reached. The test is judged FAIL if the number of bad frames is exceeded. The test optionally captures the failed frames as bitmap images and stores them into the hard disc.

**Parameters in use**
- Test Timeout (default 100 000 ms)
- Total number of frames (default 2 000 ms)
- Number of bad frames allowed (default 2)

CRC Based Sequence of Reference Frames Test

The verifies that a sequence of frames is captured in the right order. TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to provided parameters. After that captures frames to find a frame with matching CRC (check sum) of their three color components to the first provided reference. After the first matching CRC is found it compares the CRC of the following frames until the Number of frames tested parameter is reached.

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the CRC of the following frames do not match the provided list. The test optionally captures the failed frames as bitmap images and stores them into the hard disc.

**Parameters in use**
- Test Timeout (default 100 000 ms)
- Number of frames to be tested (default 20)
- Reference width (default 1920)
- Reference height (default 1080)
- Reference BPP (default 24)
- Expected frame rate (mHz)
- Frame rate tolerance (mHz)
- Reference CRCs (R, G, B)

**Note:** Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list should be different.
CRC Based Continuous Sequence of Reference Frames Test

The test verifies that a sequence of frames is captured in the right order many times repeatedly.

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and Color format) to provided parameters. After that captures frames to find a frame with matching CRC (check sum) of their three color components to the first provided reference. After the first matching CRC is found it compares the CRC of the following frames until the Number of frames tested parameter is reached. After that it resets the list and starts from the first CRC. The list is repeated until timeout or until the provided number of repetitions is reached.

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the CRC of the following frames do not match the provided list.

The test optionally captures the failed frames as bitmap images and stores them into the hard disc.

Parameters in use

- Test Timeout (default 100 000 ms)
- Number of frames to be tested (default 20)
- Number of iterations
- Reference width (default 1920)
- Reference height (default 1080)
- Reference BPP (default 24)
- Expected frame rate (mHz)
- Frame rate tolerance (mHz)
- Expected color format
- Reference CRCs (R, G, B)

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list should be different.
Link Test Set – DP Rx

Link Training at All Supported Lane Counts and Link Rates

Test requests link training on all supported lane counts and link rates. Each link training must be successfully completed in order to pass the test.

Parameters in use

- Test Timeout (default 5 000 ms)
- Max lane count supported by DUT (default 4)
- Max lane rate supported by DUT as multiple of 0.27 Gbps. (valid settings 6, 10 and 20; default 20)
- Long HPD pulse duration (default 1 000 ms)
- Link training start timeout (default 5 000 ms)
- Delay between test cycles (default 3 000 ms)
USBC Electrical Test Set – DP Rx and DP Tx

Up Face Port CC and Vconn Test

This test verifies operation of CC lines for short-circuit and open-circuit failures, and that hardware directly related to CC lines is working properly. During the test, TE will operate as Type-C UFP device.

In the start of the test TE temporarily disconnects the CC lines to simulate a re-plug event. After the re-plug event, Ra is connected to CC2 and Rd is connected to CC1. DUT is expected to have Rp, or a current source applied to both CC1 and CC2 lines. The impedance of DUT’s Rp resistor, or current source must be adjusted so that the voltage drop on Rd resistor in TE is within one of the voltage ranges defined by the provided parameters.

TE will measure the voltage drop on Rp.

Once DUT has started to provide Vconn on CC2, TE will measure the voltage present on CC2. After that TE will do a cable-flip and repeat the steps as above.

For a PASS result, measured values from CC1, CC2 and Vconn must be within ranges defined by the provided parameters.

Note

Configuration items for this test should be programmed with averaged values from several “golden sample” DUT’s.

Important

In order to run this test with UCD-340, Unigraf Electrical Test Cable must be used and Electrical Testing feature enabled with a corresponding license.

Parameters in use

- Test timeout (default 5 000 ms)
- R-plug duration (default 1 500 ms)
- DUT attach timeout (default 10 000 ms)
Appendix E: Sink and Source DUT Tests

- CC low voltage limit for default current (0.5/0.9A) (default 261 mV)
- CC high voltage limit for default current (0.5/0.9A) (default 588 mV)
- CC low voltage limit for 1.5A current (default 675 mV)
- CC high voltage limit for 1.5A current (default 1 189 mV)
- CC low voltage limit for 3A current (default 1 238 mV)
- CC high voltage limit for 3A current (default 2 181 mV)
- Vconn low voltage limit (4 750 mV)
- Vconn high voltage limit (5 500 mV)

### AUX (SBU) Lines Test

This test verifies operation of SBU lines for short-circuit and open-circuit failures and that hardware directly related to SBU lines is working properly. During the test the TE will operate as Type-C UFP device. For this test, DUT must support DisplayPort Alternate Mode.

In the start of the test TE temporarily disconnects the CC lines to simulate a re-plug event and waits for DUT to enter DP Alternate mode.

Once DUT has entered the DP alternate mode, TE will measure voltage levels on SBU1 (AUX+) and SBU2 (AUX-) lines. Please notice that if TE is acting as DP Sink, it will de-assert HPD signal to keep AUX bus at IDLE state during the voltage measurements.

Once the voltages are measured, TE will do a cable-flip and repeat the steps as above.

For a PASS result, the measured voltages must be within the ranges defined by the provided parameters.

<table>
<thead>
<tr>
<th>Note</th>
<th>Parameters for this test should be programmed with averaged values from several “golden sample” DUT’s.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Important</th>
<th>In order to run this test with UCD-340, Unigraf Electrical Test Cable must be used and Electrical Testing feature enabled with a corresponding license.</th>
</tr>
</thead>
</table>

### Parameters in use

- Test timeout (default 5 000 ms)
- DUT Capabilities flags (default 7)

<table>
<thead>
<tr>
<th>Bits</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>DUT Support for DisplayPort Alt Mode (1 Yes, 0 No)</td>
</tr>
<tr>
<td>1</td>
<td>DUT can act as power source (1 Yes, 0 No)</td>
</tr>
<tr>
<td>2</td>
<td>DUT can receive power from TE (1 Yes, 0 No)</td>
</tr>
<tr>
<td>31:0</td>
<td>Reserved</td>
</tr>
</tbody>
</table>
- R-plug duration (default 1 500 ms)
- DUT attach timeout (default 10 000 ms)
- DP Alt Mode timeout (default 5 000 ms)
- DP Alt Mode AUX+ line idle low voltage (default 100 mV)
- DP Alt Mode AUX+ line idle high voltage (default 600 mV)
- DP Alt Mode AUX– line idle low voltage (default 2 500 mV)
- DP Alt Mode AUX– line idle high voltage (default 3 000 mV)
DUT as Power Sink

This test verifies operation of Vbus and GND lines for short-circuit and open-circuit failures. The test is performed using mandatory PDO for power contract. During the test, the TE will operate as power source, and advertise only $vSafe5V$ for power contract. In order to run this test, the DUT must support Power Sink role.

In the start of the test TE temporarily disconnects the CC lines to simulate a re-plug event and waits for Power Contract to be established.

After Power Contact has been established TE will wait for the delay stated in Measurement delay parameter and measures the current in Vbus and GND lines and the voltage of Vbus. The purpose of the delay is to allow the DUT time to stabilize its power consumption.

The test assumes that the current flows through the four separate Vbus and GND lines evenly. Since current measurements are done sequentially, any variance in DUT power consumption during the measurement can cause this test to fail.

Total currents are calculated for Vbus, and for GND. The difference in the measured values of the four connections may not exceed the programmed deviation limits.

For PASS result, the measured Vbus voltage, Vbus current and GND line current must be within the ranges defined by provided parameters.

In order to run this test with UCD-340, Unigraf Electrical Test Cable must be used and Electrical Testing feature enabled with a corresponding license.

Parameters in use

- Test timeout (default 5 000 ms)
- DUT Capabilities flags (default 7)

<table>
<thead>
<tr>
<th>Bits</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>DUT Support for DisplayPort Alt Mode (1 Yes, 0 No)</td>
</tr>
<tr>
<td>1</td>
<td>DUT can act as power source (1 Yes, 0 No)</td>
</tr>
<tr>
<td>2</td>
<td>DUT can receive power from TE (1 Yes, 0 No)</td>
</tr>
<tr>
<td>31:0</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

- R-plug duration (default 1 500 ms)
- DUT attach timeout (default 10 000 ms)
- Power Contract timeout (default 10 000 ms)
- Vbus voltage low limit (default 4 750 mV)
- Vbus voltage high limit (default 5 500 mV)
- Vbus current deviation (between wires) (default 100 mA)
- Return (GND) current deviation (between wires) (default 100 mA)
- Measurement delay (default 2 000 ms)
- Minimal current (default 20 mA)
DUT as Power Source

This test verifies operation Vbus and GND lines for short-circuit and open-circuit failures. During the test, TE will operate as power sink and selects only V Safe 5V PDO for power contract. In order to run this test, the DUT must support Power Source role.

In the start of the test TE temporarily disconnects the CC lines to simulate a re-plug event and waits for Power Contract to be established.

After Power Contact has been established TE will wait for the delay stated in Power measurement delay parameter and measures the current in Vbus and GND lines and the voltage of Vbus. The purpose of the delay is to allow the DUT time to stabilize its power consumption.

Note
The test assumes that the current flows through the four separate Vbus and GND lines evenly. Since current measurements are done sequentially, any variance in DUT power consumption during the measurement can cause this test to fail.

Total currents are calculated for Vbus, and for GND. The difference in the measured values of the four connections may not exceed the programmed deviation limits.

For PASS result, the measured Vbus voltage, Vbus current and GND line current must be within the ranges defined by provided parameters.

Important
In order to run this test with UCD-340, Unigraf Electrical Test Cable must be used and Electrical Testing feature enabled with a corresponding license.

Parameters in use

Parameters in use

- Test timeout (default 5 000 ms)
- DUT Capabilities flags (default 7)

<table>
<thead>
<tr>
<th>Bits</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>DUT Support for DisplayPort Alt Mode (1 Yes, 0 No)</td>
</tr>
<tr>
<td>1</td>
<td>DUT can act as power source (1 Yes, 0 No)</td>
</tr>
<tr>
<td>2</td>
<td>DUT can receive power from TE (1 Yes, 0 No)</td>
</tr>
<tr>
<td>31:0</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

- R-plug duration (default 1 500 ms)
- DUT attach timeout (default 10 000 ms)
- Power Contract timeout (default 10 000 ms)
- Vbus voltage low limit (default 4 750 mV)
- Vbus voltage high limit (default 5 500 mV)
- Vbus current deviation (between wires) (default 100 mA)
- Return (GND) current deviation (between wires) (default 100 mA)
- Measurement delay (default 2 000 ms)
APPENDIX F: ADVANCED FILTERS

This the description of the advanced methods for filtering transactions in DP AUX analyzer in Event Log. The following help text can be seen as well by clicking the Help button of the Edit Filter Rule dialog.

Note
Please note that Filters are a very powerful tool. They can however unintentionally hide valuable data from you. Please be careful when applying custom filters. A good practice is to start from an existing filter and gradually add new rules while testing their performance.

Note
Filtering and selecting the columns for display do not affect the actual data acquisition. All transactions and their full data are always captured.

Data pattern expressions
A data-pattern expression is a string that describes how to determine if a data-block should be considered as "matched" or "unmatched". The syntax used with data-pattern expressions in Aux Channel Analyzer is described below.

The data-block must be covered completely by the data-pattern expression. If the data block is shorter, or longer than the expression, then the data block is determined as "not matched". The '*' wildcard can be used to allow data blocks of any size to match.

Whitespaces and new-lines are ignored and are allowed anywhere; White spaces and new-lines can be used strategically to make the expression more readable.

For example: "*!(10)?(10)" is the same as "* ! (10) ? ? (10)"

Comment blocks:
Comments must be written enclosed in curly-braces '{' and '}'.

Wildcards
Wildcards used are '*' and '?'

* = Match any single data byte only.
?
 = Match any number of any data bytes. (including the possibility of matching NO data bytes)

For data matching, the byte value must be enclosed in braces '(' and ')'. Use prefixes $ to indicate HEX value, '%' to indicate BIN. No prefix indicates DEC.

Examples:
* ($10) ($00) : Matches any data pattern that has the bytes $10, $00 at end of data.
? ($10) ($00) : Matches 3-byte data pattern that has $10 as second byte and $00 as third byte.
* ($10) * ($00) : Matches any data pattern that has $10 and ending to a $00 byte.
* ($10) * ($00) * : Matches any data pattern that has $10 and $00 after it.
($10) ? * ($20) * : Matches any data pattern that has $10 as first byte, followed by $20 with at least one other byte in between. (i.e. will not match $10, $20)

Use '!' to invert the match:
!($00) = Match any data byte that isn't $00.
Use '?' within HEX or BIN value to ignore that bit in comparison:
($???) = ? = Any data Byte.
($?0) = Any data byte with bits 0-3 cleared.
(%1????????) = Any data byte with bit 7 set.
(%0???????1) = Any data byte with bit 7 cleared and bit 0 set.
The '!' inversion can still be used:
!(%???????00) = Matches any data byte ending to %10, %11, %01 but not %00.
To match a single data byte with more than one value, separate the values with comma ',':
(0, 1, 100, 200, 254) : Matches a data byte whose value is 0, 1, 100, 200 or 254.
Invert the value group match with '!'. Value wildcard '?' is also allowed.

Example:
!(1, 2, 3) : Match any data byte other than 1, 2 or 3.
!($?f, $f?) : Don't match data bytes with bits 0-3 set to 1, or data bytes that have bits 7-4 set.